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(.\ #1 Flow Graph with Conversation Filter

 If you want to grab sequence, retransmission, and
fragmentation between hosts, Flow Graph is a good
idea to visualize packets.

« Open trace file “sf19-1.pcapng” and choose Statistics
> Flow Graph to create Flow Graph
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(O‘ #1 Flow Graph with Conversation Filter (@

« Wireshark shows Flow Graph of all packets, there may
be tons of hosts in a Flow Graph, so use conversation
filter to focus between 2 hosts you want to.

» Choose a packet that you want to visualize
conversation, right click to choose “Conversatlon Filter”

> “IPv4" to set display filter. e
. Then click D 3|
Statistics > FlowGraph 7 |

nnnnnnnnnnnnnnnnn
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.\ #1 Flow Graph with Conversation Filter
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« Check “Limit to display filter” to limit conversation.
* You can visualize Flow Graph between 2 hosts.
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(.\ #1 Flow Graph with Conversation Filter (@

 If you want to see flow of TCP level connection,

« Choose a packet and right click "Conversation Filter”
> “"TCP”, then select Statistics > Flow Graph, click
“Limit to display filter” and change flow type as TCP.

« Time 2.351631 shows TCP retransmission and you can
also check the same Seq / Ack numbers.

B3RS | - Same Seq / Ack says
1948174 sas3 L A o a0 az 81831 Ack = 3413 The sent segment is still
1945441 - e 1 97 SHBY A= s not ACKed and receive no

i e 4 a= 3413 Ack = 33534

1948512 t vet
1943560 gt et
2351631

2364125




#2 New Map

« Wireshark 3.x revived Map function and we can
visualize traffic by Map using Endpoints plugin.

« Open “sf19-2.pcapng” and click Statistics > Endpoints
> UDP tab, then click Map > open in browser
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#2 New Map

« Set “Cluster radius” slider to the right edge ( max ),
then click blue dot to see UDP in entire Japan area.

« Set “Cluster radius” slider to the left edge (min),
so you can find each address grouped by AS number.

| This is a good way
‘ to understand traffic
Em ]m by L4 protocols
| . geometrically, such as

] country and AS.




(.\ #3 TCP Stream Graph

» Wireshark can list up all TCP/UDP connection using
Conversation table, so you can pick up slow connection,
create 5 types of TCP Stream Graph to visualize socket.

 Open “sf19-3.pcapng”, click Statistics >Conversation
> TCP tab to list all TCP sockets and check Duration
column grey bar (you can also sort the column)
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#3 TCP Stream Graph

« Pick up the conversation which took 546.0800 duration.
« Sort again with Rel Start and count the stream ID

(TCP stream starts with 0, and this connection is 4 )
« Confirm the direction ( from B to A : downstream )
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(.\ #3 TCP Stream Graph

* Press Graph button to visualize TCP steam

Time / Sequence (Stevens) : understand stagnation
Time / Sequence (tcptrace) : understand stagnation as well as window size

Throughput : understand theoretical performance and segment length
* You can drag/zoom, and refer each packet number

according to Wireshark main screen.
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(.\ #3 TCP Stream Graph
« Create Round Trip Time Graph and check RTT

Ave. RTT<1ms Fast Intranet ( may not think about TCP window mechanism
but you still need to think of Delayed ACK (40ms), Nagle and so on.
RTT<50ms Extranet or Domestic Internet (You may think of Retransmission
RTT>100ms International Internet or long range WAN links.

(You must think of TCP receive window control a. k a LFN) o |
- Average round trip time is about " e i
100ms in this time (the plotof 0 .} 1/ RTI
ms just says there are no packet ) LIS
so let’s create Window scaling |
Graph to determine TCP RWIN
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(.\ #3 TCP Stream Graph

« TCP window control mechanism works in big RTT
environment ( it takes long time to ACK, so we need
buffer for efficient conversation. ).

* There are enough margins of TCP wmdow 5|ze
(Green RWIN vs Blue bytes out ) st

 This trace file was capture in ,_ |
old phone WAN link ( 128kbps ) ' |
slow RTT and narrow bandwidth | Jindow thatis notused

* You may think about TCP RWIN |
in LEN ( Large Fat Network e T
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#4 RTP Graph

« Wireshark has Telephony menu to analyze VolIP,
SIP/RTP/RTCP packets and you can also listen too.

« Open “sf19-4.pcapng” and click Telephony >
RTP Streams, and click a row of RTP stream and press
Find Reverse to select forward and reverse streams.
( or Shift + Click to select multiple rows )

« Press Analyze button to see both direction at a glance

M ireshark  RTP Streame « sF1%-4-1-sip.prapng
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$n|.sr|:e.:f;.ddress Source Port Destingtion Address  Destination Port SSRC Payload Packets Lost Max Deltz (s} Max Jitter Mean Jitter Status
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#4 RTP Graph

* Select Forward and Reverse tabs to investigate stream.
* Visualize RTP at a glance to press Graph tab.
Delta: <150ms OK <400ms Alert >400ms NG
Jitter: 20ns — 1 micro sec. ( as the case may be by Human)
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#5 10 Graph

« IO graph is common method to visualize traffic,
selecting adequate Y axis is very important.
1. Packet count graph : set Y axis by packets
2. Bandwidth graph : set Y axis by bits per seconds
3. Field value graph : choose math function to match.
4. Response time graph : set Y fields as http.time, etc.
« Open “sf19-5.pcapng” wireless trace file,
and change profile to “customized IO Graph”
 C(lick Statistics > IO Graph
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#5 10 Graph

« What style is good for IO Graph ?

 If you want show the movement of the value,
set Line is good idea, and if you want to show the
ratio of partition, use Stacked Bar and Bar.

T T — Line is good for A R A ' Stacked bar at
. understanding : 1 the latter
' the movement 7 [ ( backward)

L) e Baris casy to ([ 1 il "‘ 'f'i'f | Stacked bar at
L o Suebetneceanellle o SRRk cttnnaliant, understanding . bbbl 1 o it the first
T . the value at the "“L'mmm. | T ( front)
W B0 : moment e

=ih tiprl - Faam b’
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#5 10 Graph

Set Y axis as packets to visualize counting frame by time.
For example Wireshark shows all packets vs TCP error
packets ( default ), Line is used by all packets, Bar is
.. used for TCP error packets
+ o A “set Y axis by packets” can
-l | visualize counting frame by time
- it is good for understanding
et llbale, e ration of error, retransmission
C =t 5= = and frame types.

¢ — | 0§ [ i o '-..-.- '.‘-:.-I_E :
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I SSSE— ] " Left Graph shows the ratio of
OB oAl | ‘wireless frame types, such as
o \ i 'i' | management control and data.
i Ht { | | “ MH\ HM H You can understand the status
"I:E%t el syl

nght Graph shows the ratio of ] iu V.
data frame and retransmitted
data frame. ( wlan.fc.retry==1) +.._;'f." Lﬂlllilﬂl.l.ll.ddlill__.
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#5 10 Graph

2. Set Y axis by bits per seconds to visualize bandwidth

"+ setY axis by bits
| Read Y axis as 108 Mbps
= | | » Compare CLIENT
. (ip.addr==192.168.100.135)
_ o and Google traffic

~— < - (ip.src_host contains google)
= om. . ==& = e “setY axis by bits” IO Graph

sl Bt

o - - = s good for throughput

#sf19us e UC Berkeley e June 8-13

LLLLLL




3. setY field and choose math function to visualize

specific field value . Add two items of TCP
R RWIN and TCP segment.

:::::

N 2= e SetY Field as the
- | average of calculated
i | RWIN (tcp.window_size),
b — and maximum of

e T segment length (tcp.len)

.....

O gavg po hemteort. il ienalie Eat. Hare -
= TCF AWEN aus pe=aiil e [l Line BN Tk [E—— ()
5] T Sagrrmnt iemggth  ipee=tiL1G [ M BARTY [l gl [ b . = n
' '
# =m & i (W ez () oo Bebwnad |1 Tirws i Loy =
Ll Camw v [
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#5 10 Graph

Wirasharh 10 Graphs. 0 0-5-1-iograph peapny | o Add tWO items Of H-I_I-P
HTTP response time ( http.time ) DNS response t|me_

DNS response time ( dns.time )

Y 1cMP response time (fomp.resptime ) « SetY fields as Maximum
3 e (0] . e segment . .

i (icp.analysis.ack_tt) of http.time and dns.time.
« Compare response time.

— * Not HTTP but DNS is the
-+ problem at the worst

Case.
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(.\ #6 Copy table values as CSV

« IO Graph is very useful to visualize traffic, but
it uses only Time as X axis... We want to visualize
traffic using various dimension except for Time.

« Wireshark has various plugin table for statistics.
You can copy table values as CSV, then utilize them
to Excel as Histograms and so on

« Open “sf19-6.pcapng” that contains 10 mins wireless
client traffic. And choose Statics > Endpoints,
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« How about visualize host name as X axis ?
Check "Name resolution” and press Copy “as CSV”
and paste them to “sf19-6-1.txt"
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(. #6 Copy table values as CSV

i

A71%-B-1-sowtwhut, - T .
Tk HRE WD ERA U -D ALTH
DSR 3 im@ en|PPR Bl
W ST 0 B Do G i . FETY T FETT TR L P
i View® 15168 " ¥ ] I
117478 :
A
G, 15 ] | & [adiress JPack A Wi A5
¢ Dooo
biszad i grmoreopn A 468 @ §ER § gagiAusr [ | Z335 il
TN R e g B 200 Mavos
17632, L= ot 15148 Goog
AiE1a cing MRty 16508 M

« Change extentions from txt to csv, start visualization
using Microsoft Excel or other apps.

 In this case, using Excel to create a new sheet.

« Open sample visualization example table file
“sf19-6-1.xlsx”

#sf19us e UC Berkeley e June 8-13



» Just cut Address,

= .~ |Someone loves
~ |www.jurassicworld.jp

Packets, and Bytes
Rows, then paste
another tab. Then
Insert > Graph to
create Hisograms
Someone loves
Jurassic World
movie.




- - ® Copy CSV to another SEHORTE 7 X
oo sheet, edit rows MRS

: = ] . City G
= following City, Packets |=sos=w |
i (5] JPackets  Butes =111 |2
e and Bytes. Then group |zssie
4 Ashburn 3z 9829 . . = P
i —T— by City name, clicking | e
! | Baverly Hil 1 88
B 140 e Data > subtotal
1 [Cakm 1 610 .
come =« Set group by City, S ———
o S T count by Total Of (1 T2 B A= SHBATH(E)
e CIstEr—50TERATE
cowe ¢ ow= Packets and Bytes T ]

19 |Chicam 1 L]

5 e | rows, then press OK
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Press left side
group button [2].
Copy City, Packets,
and Bytes row
subtotaled by City
and paste values
into another sheet.
Edit some cells to
limit top 100 data
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A

.......

#6 Copy table values as CSV

/rsun

QYR
B
+)

A= MIUT

« Create another tab and copy City, Bytes and Packets.

Insert Graph
> Bing Map
Press Filter
button to set
data region.
You can see
packets and
data in Map
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(.\ #7/ Create statistics using tshark

« Tshark is a CLI version of Wireshark, so
tshark can use some statistic plugin with —gz option.
Check online help with “tshark —gz help”

C:¥Users¥megumi¥Desktop>tshark —qz help

tshark: The available statistics for the "-z” option are:
afp, srt
ancp, tree

« The option of protocol hierarchy statistics chart is
“io,phs” so open “sf19-7.pcapng” with “-gz io,phs”

t:EUzerSEmegumi¥D§Sktqpﬁt5hark -r st19-7.pcapng -9z io,phs
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. We got protocol hierarchy statistics
of all protocols in text format.

-or making pie chart we need to
orocess text data to match CSV.
Remove “frames:” and “bytes:”
using sed -e 's/frames://' -e

1_ 's/bytes://* using bash

.. * Redirect output stream as phs.csv

- tshark -r sf19-7.pcapng -qz io,phs | sed -e

+ 's/frames://' -e 's/bytes://' >> phs.csv

= T cf10us o UC Berkeley o June 8-13




(.\ #7 Create statistics using tshark

 tshark -r sf19-7.pcapng -gz io,phs | sed -e 's/frames://’
-e 's/bytes://' >> phs.csv
you also may use “tr -d ' ' to remove space character

« Open csv in Excel and create a new sheet and copy
from original data and remove unnecessary lines.

« Set Data>Delimiter as space and add header line

 Insert Graph > Donut Pie Chart and customize color,
size, index, title, etc

 Finally we can find UDP echo is the majority
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(.‘ #8 Collect fields for Visualization

« Tshark is a CLI version of Wireshark, as well as nice
data processing tool for visualization from trace files.

« Check —T option and you can pick up any fields of
dissector from trace file like —T fields —e ip.src

« This time we want to collect host information of http
open “'sf19-8.pcapng” using tshark
and collect http.host field information as below
tshark —r sf19-8.pcapng —-Y http.request —T fields

—e http.host ( use —R read filter if huge trace file )



(.\ #8 Collect fields for Visualization

¥llsers¥megumi ¥lesktoprtshark -r st19-8.pcapng -Y http. request -T fields -e http.host
. kantei . go. ip

« The output contains host header information in each
http request, start data processing for visualization

« At first we need bash and the typical technics below
sort an output stream, then count the same line,
and sort again for descending for top list
tshark -r sf19-8.pcapng -Y http.request -T fields -e
http.host | sort | uniq -c | sort —rn
(sort alphabetically and count duplications )
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(.\ #8 Collect fields for Visualization

Jzerilpes] D Amnt Ao/Users/meguni /Desktopd tshark -r =f19-8.pcapng -Y http.request -T fields -e http.host | =ort |

unig -c | sort -rn
1%3 www.ﬂ{urassicworld. ip Sort descending of
pw kantei . zo. ip
he fuji-fo.fuji-scko.net Count / hostname
17 192.168.100, 253
4 eigacheck. in

» Redirecting the output stream as csv

tshark -r sf19-8.pcapng -Y http.request -T fields

-e http.host | sort | unig -c | sort -rn >> hostlist.csv
* Open CSV file and set delimiter using Excel

v [3] s T2 . B B L
B a0 (¢ o nGE Y o = ® | -z 2 :
Access  Web FEAF Eofun EE) A | mAEE - EUMEE via §@O T80 BE What 045 S—E -
5 & Tl F=8 =2 B W . g T et 25 W Acham . . -
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(.\ #8 Collect fields for Visualization

T TRRRL T L | b ;
— | whanes kanhel o jp e
e B-ii WAL AefidFl @R T8 I8 sl sl TOP WEBSITE
ram) - erTwa YW NG [+ | @ B [ ] (] B 60 002 17
h & b e 4
ey Al : i
i

staic ada-twitear com 112 ddddbdddbbd

[i (i) i -
1 A ]
| 112 wwew jrasicward o i i ;
| Lh ‘HimEchie googlecode com ]
| ¥ B wwrw kil @ in
% | 11 |efsinmsott com i oA LA44Li3 ]
| 2 56 Fuj-foful-codo net : L &L L L] [ L]
g | 17 ednd-upe red 3
i | % 17 e 183100353 3 .
13 ‘mooune gravaksr.oam 2
|id 4 nigactmihin | :
| ® i | 14 pee o e TwiTae Lam 1 55 i = -il . i‘:
| TR | 13 ‘mawcdn bootzimpodn com 2 Lt L
- ¥ WL i k- Ca U T o P Ao e il .
) 3 s e 15 “Jures goojpeach. 2
e B W imEshiv poojiecode coe R i oy .
RO | STm 5 e - | 18 ware mafieonne ciieet com 1 1? *i
| 48 lwesre ke g e 1
| an sretican focmbank eam 1
| 21 peedwpooe i
SLTEST, 1
JfTe Fuf=_p et

4 i
3

» Set delimiter as space éh'c'l_;éureat'e a new sheet,
e copy and paste host and count rows into new sheet.
 Insert People graph and save as topwebsite.xIsx
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(.\ #8 Collect fields for Visualization

~ Transport Layer Securily
“ TLSw1.2 Record Layer: Handshake Protocol:

Content Type: Handshake (22)
¢ HOW abOUt TLS ? Version: TLS 1.2 (@xe303)
Length: 196

o Client He”O messages may ~ Handshake Protocol: client Hello

Handshake Type: Client Hello (1)

COntaIn hOSt name Length: 192

Version: TLS 1.2 (dx0303)

as one Of eXte NS | ons Random: 5bag3ae22a999942887db7desbaboe

Session ID Length: @
(tls.handshake.type== 1) Clppar-auttas Lo
e Server name fields locates in v iy

Extensions Length: 113

one of extentions in Client Hello - cencion: server nane (1en-17)

Type: server_name (&)

(ssl.handshake.extensions_ e

» Server Name Indication extension

Server_na me ) Server Nare A i Tl server Name list length: 15

server Hame Type: host_name (©)
server Hame length: 12

#sf19us e UC Berkeley e Jung server Name: www.bing.com




( \ #8 Collect fields for Visualization

Set display filter as “tls.handshake.type == 1" and

collect fields of “ssl.handshake.extensions_server name” in

trace. So use the command in bash to create csv
tshark -r sf19-8.pcapng -Y ssl.nandshake.type ==

-T fields —e ssl.handshake.extensions_server name
| sort | uniq -c | sort -rn >> tishostlist.csv

« Note: sometimes only old filter string is accepted, so
we use ssl display filter word instead of tls in tshark
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( ‘ #8 Collect fields for Visualization

i/mntSo/Users/megumi ADesktopd tshark -r sf19-8.pcapnz -Y ssl.handshake.type==1 -T fields -e ssl.handsh

ake extenglong _server_mame | sort | unig -c | sort -m
9 static.xx.thedn.net
¥ =.vtimg. com

|
| host oounk
B tg'SOI‘?dm'Com , : 2 ateticxo fbodn net B -r,‘; -"L"ll'r‘-q('-'.-rjc
B FES.CIﬂemaCItF.CO.JD [12 I"-:""ilf""‘" 7 L sty
b |hb.zoogleusercontent . com sy
5 gocginuma ' ]

« If you got blank in server | =zms @ SAAA4AAAS
name, there is no host == 7 ::::::"‘

information in Client Hello : =z -

: - : . uun

» Create People Graph in

77 algcom 3 E iiii‘i

the same way and save ;== 4 T

thirga—wn data microsofL com
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(.\#9 Export Packet dissection to JSON(&

I talked about Visualization using Elastic Search and
Kibana from json file from Wireshark at Sharkfest'17

R /1 & - .

Decode / dissection Big data analysis Visualize

Full-text search Real-time analysis

« Wireshark 3.x / tshark now support many options to
output json file from trace file and live capture.

« -T json / jsonraw / ek (Elastic search Kibana )
and we can also use —G elastic-mapping and
--elastic-mapping-filter <protocols> option
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(o‘#9 Export Packet dissection to JSON(#

5‘4 elastic+ E Kibana 1.Check your machine supports Java

C:¥Users¥megumi>set | find "JAVA"
Full-text search Real-time analysis ~JAVA _HOME=C:¥Program Files¥Java¥jre1.8.0 212

Big data analysis Visualize

: 2.Access https://www.elastic.co/jp/downloads
Setup Elastic and 3.Download Elastic search, Kibana

Kibana environments 4. Extract zip and open each bin folder

5.Execute elasticsearch.bat
< A 6.Check “started” in command prompt
7.0Open http://localhost:9200
8.Execute kibana.bat
9.Check “Kibana index ready”in prompt
10.0pen http://localhost:5601

#sf19us e UC Berkeley e June 8-13
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http://localhost:9200/
http://localhost:5601/

http://localhost:9200

http://localhost:5601

« This time I used old set of Elastic + Kibana
elasticsearch-2.4.1 and kibana-4.6.1-windows-x86

(el TS0 1, b ol Pl 2D |

[Pa g Gannrie] sermionll,

1 [Faram Guahrin,

[Paige Luthrie + langresoression, larg groo
[Pakge Gadnria] wsiog [1 monts [[CF 11 »
n |_u .._\.-'I e

_|'i.i Laith

1 [Pa ..- Guthrie] started
. 3 .r-l--‘l-l o cligk walermark [F areedid o
-'"lr-‘“‘.t:'lllc.-rrt'f last jcomarchet, 4, 1Wcata¥e last | comanchifn 1.1-\.--, Fres:
thig rede

ra-al lncat |on, decider ] [
Lk rsinenm| =gkt octelast iczearc
e this reck

i ule ol low digk sitarsads [BE] excaeded o
| Vel oo L4, 1Wchitaie | et | comarchiinodes ] f e
A7, gkl 16 ".'.I rid beas wi |

LL S e L

: '-.I. [z 44 807] [intell=t

'|_:- ugirck ipara®l 0.0] Status charaad fr minitial jped to-green « Rasd
1 2 { cmmarchd] 0,07 Satis h;_u-'l..;.r initiad jesd 15 vel low - BaHire

bowis_trres®l 0.0 Sintus droresd {rom uninifinl ized bo gresn - Re

aninlt ial ized te J.e-er' Head
Faact

3,11 Biatus chaneed #rom
L ol f ¢

10t i e lzst fosanrchl] 0,00 St

tie changad from wel los 1o gréen = Kibara indes rea
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http://localhost:9200/
http://localhost:5601/

(o‘# 9 Export Packet dissection to JSON‘E?'.”’-

Export packet dissection to JSON ( Elastic +
Kibana ) format from sf19-9.pcapng

tshark —r sf19-9.pcapng —T ek > trace.json
Open editor and check json file

.tracEann TeraPad
IrAIlF) REE BB|E EFM) MPEOMW) Y- ALTH)

D[ | d3| Bl oo 53 DR

o, ..|1u...| L R .|4n...| [0 T e e e e
1k |ndex FoS |ndex 3 packets 2018 09 25 type D poap flle }}¢ ;
1 tlmestamp s 474777R5247687, 7 lavers " { rame” 1| frame_frame_interface id”: 0",
rame_interface_jd_f rame interface _name’ : ¥¥DEV|CE¥¥NPF {ZBB?E24 -3054=422D-8E0D
-9054F 737302017, "frame_f rame _encap_twpe 1717, " rame At rame _time”: "Sep 25, 20161
.F

75:52. 476134000 ﬁ%ﬁ“ ({Z2EEF) ", "Trame frame _offset_shift™: "D, UUQUUUUUU “f rame
rama +ima anach” - 14T4TTTRR? ATRIGANNT" *Feama. §rama + ima dalta” "0 AONOOONON "
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(o‘#9 Export Packet dissection to JSON

*OPTION*

If you we want to create json file including only tcp and
ip header, we can use —e tcp —e ip

tshark —r sf19-9.pcapng —-Tek—e tcp —e ip

Check output to confirm the json file contains only tcp

and ip header information. Also —j/-J]

-j <protocolfilter> protocols layers filter if -T ek|pdml|json selected
(e.g. "ip ip.flags text", filter does not expand child
nodes, unless child is specified also in the filter)

-J <protocolfilter> top level protocol filter if -T ek|pdml|json selected
(e.g. "http tcp", filter which expands all child nodes)
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Put trace.json into Elastic
curl -H "Content-Type: application/x-ndjson"
XPOST http://localhost:9200/_bu|k --data-binary

@trace.json
Check “successfu

III

rs/megum| Tesld ord curl -H Tontent-Tvpe! apelicat fon'ndison™ =MPIET httes localhost 3000/ _balk

1 “pach -.*l'.'-'"”_['-'-
fai |-.1 0], "statug
shards_

d

total ..-.J\.a_:LE-"u
i .-.fhv'-lnlrllh-m Gl it B«
packet -1 E-03-25",

f.1||-"'-"
-'r lon a1

1. failed
version | 1 :
et poanfile o _id;
-l Crgite il inder 1)
al 12, succassf

11" -'r'~'|1x\-"i' ke o | HesrdliCgh o 27, 7 _vers
12 sueceselul e | T bop
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(O‘#9 Export Packet dissection to JSON

We success putting json file into Elastic, but data
schema ( term mapping in Elastic ) is not correct//

curl http://127.0.0.1:9200/_mapping Al felds ypes
all fields types are recognized as “string” [EREEEE

f’rrﬂtfrfUcc-rgx’megumw’Uﬂanp$ curl http:/712/.0.0.1:9200/ mapping
{ l-:ll:-ar"ua { "mappines”: {'config’: [propert jes: { "bui [dum” :["type”;"string”, “index”: “not _analvza@P11 ], “packets-2016-09
-25‘: “mappings :{“pcap_file": r::-ror::-erfles {"avers”: {"properties”: {"data-text-lineg : | “progg data-text-lines_{
ext "1 {"tvpe": string"HT, "dns”: ["properties”: ["dns_dns_count_add_rr”: ["type”: “string”}, "dngdfins cc-unt answers ;[ tvpe
strmg "1 "dns_dns_count _auth_rr i {"type”: "string”}, "dns_dns_count_gueries”: [ "type”: "string |, "dns dns_flass i "type “st
ring”l, dns_dns_id": ["twee™: "string”l, "dns_dns_resporse_to":{"type : "string”]l, "dns_drns_time : {"type :Tstring”], "dns_f lasg
s dns_f lags . authentucated ["twpe™: "string”]l, "dns_f |ags_dns_f lass_ authorutatuve {Ttype t"string”l, "dns_f |ags dns _flass_
checkdisable™ ["type™: "string’}, "dns_f lass . dns _flags_opcode™: ["type”: "string”l, "dns_f lags_dns flags reode”: ["type™: “stri
ne ], dns _flags dns_flass_ rncavall [tvpe™: "string”], "dns Hags dns_f lags FECEIE':IFECI ["tvpe™: "string’]. n:tns flags_dns_
Hags response ;1 twe Dstring } "dns_flags_dns_f lags_truncated”: | Type : “string ), dns_flass_dns_flags z : [ type i str
ing 1, dns_text’: ‘string }, text_dns a”i{ twpe strmg 1, text _dns_crame :L type :"string’ ], text_dns_count_lab
els 1 "type: strm.g Te text_dns_ary_ class 1 type : strin text_dns_qrv_name : | tvpe : string |, text_dns_ary_rame, |
i type 2 strmg “text dns_arv_ type i t_w:-e : strmg? text _dns_resp_ ctass z type : strmg "text _dns_ resp_ len”:
{ type Dstring’l, text _dns_resp_name”: " type "string’], text_dns_resp_tt17:{ "type": strmg “ky Text _dns_resp_type : { "ty
e : string |, text dns soa expire limit™:{ tvpe ! str‘m "text dns soa mininum tt17: [Mtype”: "string”]l, "text dns som m
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(o‘#9 Export Packet dissection to JSON(#

« When you create json file using tshark / Wireshark,
there are problems about mismatch of database
schema ( a.k.a. “"mapping” in Elastic )

When you upgrade Wireshark and some protocol
dissector is updated or modified,
the output json file format may be changed.

C:¥Users¥megumi¥Desktop>tshark --version C:¥Users¥megumi¥Desktop>tshark --version
TShark (Wireshark) 2.4.2 (v2.4.2-0-gb6c63ae086) TShark (Wireshark) 3.0.2 (v3.0.2-0-g621ed351d5c9)
tshark -T ek -r stream.pcapng >> json242.txt tshark -T ek -r stream.pcapng >> json302.txt

Ciumabmagu mmup-,mm

: e
ace_id : < Frame_jintarface_id. HmsthITi?ﬂzﬁ T8 s |

& 2‘21& [6i~( 15. h-p-:: e

mm fane_:
'35 tma_f

W
_rmim l?ﬂm

t:-::tm H'HJ aﬁgzﬂe

mmm‘“st {ramm

thn.a.d.utzla'lﬂ"ﬁ tvrg pm:'r

t.vpg _pmfg

rlqh_ irterface id";

Frame_interface_id fram

|
07, "Frame_interface_id, [ H?‘-ﬁ"-l"ﬁﬁ *?B Imrs “Frame, nterT:c! id":"0", Frape_interface_id_fram
ipdes’; nggm-q'r fovar: ile joi ol By g Bk 'ilf'bmg mpr a
tinestans "I H'."?EESH {Frame’: | fr ace_id : 07, Frane_intsrface_id t ues{_ H? T?FESH'ES Imner‘.i ], rne Ir1t rface_|d"t 07, Frame_interface. |d_fram
e | ot parate’ Heals et core’s ithi). Inesime: 1l SIE00228 ", oy :
“finestams’ T 147 Ia'p'er_ﬂ. L Fm': P are_inte id': "07. "Frame_intarface_id |7tinestame HR?THSJIS‘]‘I'] Jnrere" ﬂme ane frame_interface id™:"0", frane intertage id frams
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( N #9 Export Packet ESiSi
&»

dissection to JSONETINEEY e

Type: date
- We can create adequate = _
Elastic mapping file semi- = "
automatically using tshark =~ e Type: short
- If we want to create flow = .2 Delay bit of
based schema information | Type: bool
including ip, tcp and udp Bysile:
tshark -G elastic-mapping iz
--elastic-mapping-filter kb

gt g
t:.: gnﬁn q:

Identification
field
Type: int

LT 01 T Destination
it L e IP address
[ Type : ip

ip,tcp,udp > mapping.json |
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(0\#9 Export Packet dissection to JSON

e We need to delete all data and schema
curl -XDELETE http://localhost:9200/*

* Then put mapping information into Elastic
curl -H "Content-Type: application/x-ndjson" -XPOST
http://localhost:9200/packets-2016-09-25 --data-binary
@mapping .JSon

* Check mapplng “curl http://127.0.0.1:9200/_mapping”

clsers/menmi Desktood curl hite://127.0.0.1:9500/ mapping _

I kibara™: { hﬂ:}[biQE?I' cont i .f,'-'.r"'lf-"t"’&iib-.l b s [ type = "string . “index”: Tnat_analyzed™1111], “packets-2016-09
-2 mapeines [ Tecap f i e {Tdvpamic”: Tfalse, Tpropar rties":[Clavers i [ @ r.r-ert [ i L properties™: | ip_addr 3 [
vee™:"ip"], Cip bosus I'e:;:igr Lena.li_‘: [ Ttvee s sty ring and bc-a;s. in_ length ™ 1% tvpe” ® “stri r.g: .-_ Io_bomus. |o-version ;| tve
g string ], e checksum T type s Tinteger ], Tip o -cr.l-':.mJ:- d per 1 I 1;, el '.I_a' ing" ), ig checkaun . 4 | h':-'l |,| !w-'r
tTirkeser 1.7 ip_checksua status ] Ttype ;__:'J_'prf v iR_Cipso Dstr ] p - ipsa r pe 2E
=], Lt_ci;@;-_aalh:urrrr_-d;]' type”: string ], lp_cipso_sensitivity |'&'\-‘L| A & tn.-e “she 1 ls i D‘:- ta -:iata [t -D-* :"h
te], "ip_cipsg_tas twpe"i [ Mvpe" "shart 1, |p"cu;_rt [ tvme” : ip" 1, e cur_rt_bost T [Ctipe T ipdstiefd: [t
vpe”: short”]. "lp dsfield dsco 't [ tvpe tshort7]. "o detield ecn™: | twee™: gﬁm't e r dst { |:~ el e -E |““Gt :
[Mtvpa™; 'Ei_ringjl.l ip_emoty ri™[“tve": Tin ], Tip escty_rt_host i [Ctwpe™: Tetring vl | packet”: I:}r str ; e
p_flags s [Myee": Vinteger”],"ip flass df T: {"twoe ™ hoolean]. "ie _t lass_nf [ 1 yoe ! I:Ju a i rI as b {7 tp : hor
lean'}, Jip_tlaes =f i type’: boolean ], "in_fras offeet :{"type: Cinteger “1."ip_fra [ { [aemen
$ court s [Ctype ©integer 1, ip_fragment_error i1 type i irteser ], ip_frazment milti |.| eta [t r.- hbnol 2an ] ipfr
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http://localhost:9200/*

.‘#9 Export Packet dissection to JSON

* Without mapping file

mntdc/Users/megum| Alesktopd curl bttpr/A12000.0. 105200/ maceing | }
& ibara™ " mage | nes :[ corfig”: DUbropert jes’ =0 b b’ “Mtvee”: trine’,"index”: "not_aralvzed'1]11}. s}ackr.t;—:-?[!lﬁ DE
-éﬂ rna:plnﬁa [ pcap file” j.[ l:-ror.-ert ies":["lavers": [properties”: | ‘data-text-lires : ["properties : [

et ” 2string HT. "dre”: ["oropert ies : [ "dos_drs_count_add e [Ttupe f =~+r|ru_-: . dns s _courd _answers 1| Ttvpe” 3
stri 1 "dhs_dhe_counit auth re il type s Tstring ] Tdns_dre count_gqueries ‘4' tupe : strirg ], iﬁs ds flaes"; {"type "t st
rlna.nf dns_dns_id": ["tipe™: "string’ ], “drs_dris_response_to”: | type : string ). drs_dns_time : [ “tvpe : "string’ "1, "dns flas
s dhs flags_autkﬁntu:ﬂtml Utvpe™: "strine’], "dns_flags drs flaes aythoritatjye " Mivpe strine ], dns ’rla.gs drs_f [ass

chedkdizable™: ["type: “strirg’], ‘s _f lags_ d!;rs flags_opoode™: { twpe i string’], "dns_f lags_dns flags_rcode”: [Evee™: strl

* With mapping file "mapping.json”
curl -H "Content-Type: application/x-ndjson" -XPOST
http://localhost:9200/packets-2016-09-25 --data-binary @mapping.json

L fmnt /o Users/mesmi esktopd curl http://127.0,0.1:9200/ mapping
klbar\a ["mapeings : [ confis : | 'properties :[ bt fdm ™ [ Ttyvpe " "string, Vindex "t Tpot_analyzed”] 1111, packets- 2016-09
—?5 ["mapeires”™: [Tpeas_file’ :f mic s falze”, oroperties™: [“lavers™: { propert jes™ [T [ properties™: [Tip_addr™: [t
wpetip |, Tip bogus. header length”: ["tvee": Tstring 17 ip_bagus_ip. |-‘|"‘SthM [Ttwpe":"string ], "ip_bogus_ip_versiog L tve
g ostring ]."IL’J checksum : ["tvpe™: " integer 1.7p checksum_bad_expert™: [ lwre :F'="r|'us 1, ie_checksum_calculated : [ tupe
3 |nt-=~g-_—r 15 i _checksun_status: [Ttwee ; "short "], "ip_cipso :a‘tea._nrzﬁs } tatring 1, ip_cipso_doi i tvpe T intes
1P up@o _malformed s [Ttyme: "string” ], "ip_clpso_sensitivity_|evel " *vpc- tshort ], ip_cirso_tas_data”: [Thwe"iTh
Et’ :. ip_cipsg tag_ type”: { "type ™ "short 1, Tip cur_rt T {twpe ™ "ip ], Tip our_rt host":[” Tvp-ﬂ Tstring 1, ip.dsfield™: {7t
vpe u:rt . o dsfield dscp’ s tvee “shart™] . Te dstield. ecn i type s short ] Tip dst™i [Mhee s Ui 1L iR u:lst_lw:-st
["type™: c,lrul.g 1. i empty_rt":{"type": L "1, "ip emety_rt_host™: [Mvpe™: n.rmg | - s-wlws,a-k-d ["tvpe: L.rru.xg 1.7
poflags":{ twpe": ||'|1:|E:g»:a~T I ip fla.gs dt ": ["twpe ™ booleanl, ip_f lass_mf i [ tvee”: "boolean}, |;?;__fllag:5 rb”: [Ttwpe™: "hoo
lean"], "ip_flass_sf": ["type : "boolean™], "ip_fras fo‘aet [ Mtvee”: Cinteser” 1, "o fragment " {” tupe " jrteger "]."ie f rasmen

t_court s {Mtvpe ™ mte.g.e 1. ip_frasmert _error i1 tvee : integer l, ip_frasment multipletails™: ["tvpe : boolean T, ip fr
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Put trace.json again into Elastic

curl -H "Content-Type: application/x-ndjson"
XPOST http://localhost:9200/_bulk --data-binary
@trace.json

III

Check “successfu

#sf19us o U

enrsmenuml et ond curl =M Content=Tvoe® appl icat bond'ndison”™ =MPET ke

I=n e .'J'|

vy

: 1
f.1||-~" 0], "sta "L i
on i1, shardsT: [
: ¢ “Asoedin | Hi

1 pack 2
1. "fal lad ;0] "tatus
wergion il. 1]'.-1r-'h




(N #9 Export Packet dissection to JSON(@

e Its time to use Kibana ! L —
http://localhost:5601

- Set index pattern
as packets-2016-09-25 ~ Configurean indexpattem
(may work packets-*) blediatienh ivisnetli b i

* Set Time-filed name =S A

as timestamp ( type:date ) .o
. Click “Create” e

packels-2016-05-25

Time field name @ jefiesh fslds
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http://localhost:5601/

(.\#9 Export Packet dissection to JSON(#

« Check mapping is correctly

assigned as adequate type. e ——

layers.udp.udp_time_relative as date
layers.tcp.tcp_window_size_scalefactor as number
layers.tcp.tcp_options_scpsflags_bets as bool

etc.

Enjoy Visualization

| packets-2016-09-25 o [l s |
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#10 Splunk

« Splunk is one of big data processing tools for
visualizing trace files via CSV or JSON
https://splunkbase.splunk.com/app/2748/

« We can use free if the data size is under 500MB
in Windows / Linux / macOS environments
* There are two major way to convert pcap/pcapng

B4 B8 99 Ba a% ef dc fb B2 A% & 4;
0h 10 91 tb 36 c8 £d o1 Eﬂﬂiiﬁ» -
fe 14 1t-maaLmi'uve packet WIRES HARK .

Wireshark / tshark

-

you also import pcap itself —
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https://splunkbase.splunk.com/app/2748/

#10 Splunk

« There are sample trace files including huge packets.
(https://www.bettydubois.com/sharkfest19)

« [ use 1G trace (1G-1050000Pkts.pcapng ) that contains
about 1 million packets

« Open the file in Wireshark
( recommend with ReadFilter ‘ e !

or light profile for huge file ) R N R A

and Export Packet Dissectionsto ... |
export CSV which contains just = fesseisssss o
a packet summary information ) . __
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https://www.bettydubois.com/sharkfest19

#10 Splunk

gr=emneie I this case, we use the default information of
[TFsciet it packet summary pane, such as Numbers, Source,
Destination, Protocol, Length and Info

Though you can off course customize them

Using tshark is also a good way to handle big trace files,
tshark -r 1G-1050000Pkts.pcapng -T text

>> 1G-1050000Pkts.csv
or you can use —T json for your customized dissector fields

information ( with —e or —j or —J options )
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#10 Splunk

« So input 1G-1050000Pkts.csv into Splunk,
set fields name and indexes are created automatically
« T'll not talk about Splunk in detail , there are tons of
documents and samples you can refer
Open splunk page and login (http://localhost:8000/)
1 Click [Search and Reporting] in Left pane
2. Choose time range as all terms
3. Type “source="1g-1050000pkts.csv" | chart count by
destination and set style as pie chart
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http://localhost:8000/

source= "1g 1050000pkts.csv" | chart count by destination

rce="1g-1BS@REapkes.cav” | cha count destipal |

LTy tg-185aaeepkts, cav” | chart count protacel
ETE
| i 12 70EA 1
=
T AT Ik
—— r’-. - |- L e

oF ———is

@ P F

V0300, 0305

source="1g-1050000pkts.csv" | chart count by protocol
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source="1g-1050000pkts.csv" | top length

zource™" 1 E-105080ApkEs ooy’ top length

A0t
s gl s, et 1
S Y R T P -
A R
:r.r:...-.-..---.....,.-.u::;--
i | — —— toa .
1.CaDl
od |1 ] THST—— . -..I
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- I, —
16 Bl AG3 52 el ]
g

source="1g-1050000pkts.csv" | top Info
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» USE WIRESHARK

Think Visually

« You have finished visualization oftrace file,

then its turn to think visually.

. Stop looking each frame in detail,
Look over the traffic visually. b
- You may find a new clue

which you have never found !!

~~ ”~
® »

and THINK VISUALLY
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()  USE WIRESHARK

Thank you for attending !!

Please complete the SharkFest’19 US app-based survey

Supplemental file
http://www.ikeriri.ne jp/sharkfest

Ikeriri network service

A N8Z http://www. ikeriri.ne. jp



